Retro Sprite Workshop ver1.4

User Manual

This application is a professional tool for retro game developers, especially for Commodore 64/128
or Commodore 264 series. This program produces output formats which can be used in external
development tools, such as Macro Assembler.

The usage of this program assumes that the user is experienced in VIC and TED graphics, knows the
difference between high resolution (1 bit per pixel, 2 colors) and multicolor (2 bits per pixel, 4 colors)
and the pixel arrangement of the color modes.

What you can see after start

The application starts with a default, empty project. Everytime when you want to create a new,
empty project, just restart the application or click on Create Project in the File menu.

This image below shows the screen of an empty project.

;‘! Retro Sprite Workshop - Blank Project=== Current Project Name - O X
File Edit View

Project Sprites  Project Metadata and Settings
[ - No sprite is opened for editing

Double<lick on an image on the left-side image list

| Name Details

8 x B pixels

Byte Order
CharacterBased
2 colors

sprite

Image Editor Panel

Sprites in the project

Add New Sprite Capture new from Screenshot

One image, 8 bytes == Status information of the project

You can swith between the images and the project metadata page using the tabs on the upper left
corner of the working area.



I".‘ Retro Sprite Workshop - Blank Project

File Edit View Help M/General Project Settings

Project Sprites  Project Metadata and ngs

Project Name ‘Blank Project

|

Comments

Platform |

Created On
Length 8 bytes ($0008)

[J Automatically export source code on save
[ Include comments and metadata in source

Export to ‘

Char Index o
Offset 0 &

One image, 8 bytes

The blank project contains one sprite with no pixels. To open the sprite for editing, double click on its

name on the left-side list.

On the top of the Image Editing Panel, the basic settings can be changed related to this sprite. The
width and height is about the dimensions, the Multicolor switch changes between 2 colors and 4
color mode. The Byte Order selection controls the rendering of the byte stream in case of exporting

No sprite is opened for editing

Doubleclick on an image on the left-side image list.

the sprite for external development tool, for example Macro Assembler.

F_‘ Retro Sprite Workshep - Blank Project
File Edit View
Project Sprites  Project Metadata and Settings

Name Details

2 colors

8x 8 pixels
Byte Order:

CharacterBased

Add New Sprite Capture new from Screenshot

One image, 8 bytes

Image  Metadata and Settings
Width 8 pixels (1byte) v
Height 8 5

Byte Order ' Mixed (Character-Based)
(] Multicolor (2 bits per pixel)

v

Basic settings of the sprite

Raster editing area

selected on the top

Color settings, depending on the color mode

p Zoom: 100% ¢




Understanding of the Byte Order Setting

Horizontal
Byte Index 0 Byte Index 1
Byte Index 2 >
N
Byte Index 30 Byte Index 31 ’

This setting is suitable for the Commodore 64/128 hardware sprites.

Vertical
Byte Index 0 Byte Index 16
v W
Byte Index 15 Byte Index 31

This arrangement is the optimal data structure to create images for software sprites.

Mixed (Character-Based)

Byte Index 0 Byte Index 8
Character Character
Index 0 Index 1

Byte Index 7 Byte Index 15

Byte Index 16 Byte Index 24
Character Character
Index 2 Index 3

Byte Index 23 Byte Index 31

Best selection for rendering images used for character screens.



Working with Byte and Character Indexes during editing

g e When you are moving the mouse over the Raster

Widh  16pbels (Zbytes) Byte Order | Muxed (Character Based)

Editing Area, the status bar shows different

Heght 16 = (2] Muticolor (2 bits per pixel)

information, based on the current Byte Order setting.
The position information shows the x and y
coordinates within the image and the Byte/Character
indexes, where the zero index is always the top left
corner of the image.

Background Mo 1

Pasition Informatien |& Col=4; Row=8; Charindex=3; Byteindex=24 Proom:100%

Drawing Sprites

Please note that this tool is not a professional image editing image  Metadata and Setings
tool. Do not expect extended graphic functionality, such as Widh |16piels Rbytes) v|  BleOrder |Muxed CharacterBased) v
shading, layering or masking. el s B L e et
The image area provides basic retouching functionality to put
and remove pixels. Just click on the grid to cycle through the
available colors. - ’
Flip Image »

| Shift Image »

Right-clicking on the editing area will open a context menu Rotate Image »

with basic image manipulation possibilities, such as Saplimesipein e Scmmraiet

Rearrange Color Pixels...

flipping/mirroring, shifting and rotating. T
\
|
|

The Rearrange Color Pixels option is a common way to refactor your images when the color pixels
should be swapped, for example exchanging Multi1 (01) color bits with the Character (11) color bits.
Rearranging the pixels is not for changing the colors of the pixels. That option physically rearranges
the bit patterns of the image regarding to the settings.

Changing the rendering colors

Below the Raster Editing Area, two or four color buttons are visible, P;::"'::;i:mmm‘ ‘ o
depending on the Multicolor setting of the sprite. Click on the EE B 'EEE =
appropriate button and the color selector will allow you to pick a

color from a palette. Please select a platform-specific palette for

best color match. This color selection will help you to visualize how

your sprite will look like on the target platform, when the

appropriate color registers are set. o

N




Sprite Medatada and Settings

The second tab of the Image Editing Panel is the

Image Metadata and Settings

. Image ID sprite

metadata page which allows you to enter -
additional information about your sprite. Eamass
When the Pre-render Software Sprites option is
turned on, the export functionality will generate
the bitwise-shifted frames of the sprite with a

. .. . . Source Code Generator Settings
given precision, configured on the Rendering
Precision combo box. The Final Compiled Size data [] Preender Software Sprtes
shows, how many bytes will the sprite occupy in High (8 frames, 1-bit step) FESRphE 22

the memory of the target platform. This value is

Final Compiled Size 32 bytes

dinamically recalculated when you require

prerendering with different precisions. The Sample >> link will open a small animation showing the

prerendered sample frame regarding to the selected color mode and precision. Please note that in

case of Multicolor (2 bits per pixel) mode sprites, the prerendering precision will be halved due to

color limitations, where 1-bit step is not available).

Manipulating the Project

Project Sprites  Project Metadata and Settings

Name Details
j— 1
8 x 8 pixels
Byte Order
pde CharacterBased
Mutticolor
= 24 x 24 pixels

Byte Order:
CharacterBased
Multicolor

Add New Sprite

Clene Sprite
Reorder Sprite i
Recolor Sprite »
List View
Delete Sprite

Add New Sprite Capture new from Screenshot

Right-clicking on the project image list will allow to select
from several options related to the project. These options
can be found in the Edit menu of the top menu bar as well,
when this image list is visible on the screen. Holding the
Ctrl or Shift key while clicking will select multiple images at
once. Some operations (Delete, Reorder, Clone, Recolor)
will be applied on all selected images when multiple
sprites are selected. Reordering the image list is important,
because the final byte stream will be rendered from the
first sprite to last in order, regarding the Byte Ordering of
each individual sprite.



Interoperability with External Development Tools

Please open the Export as Source Code options from the File menu. The Export to File option will

allow to browse a target file and gives the possibility to select the output format.

E:‘ Retro Sprite Workshop - Test project v1.1 - testproject.spr®

File | Edit View

Ci\Users\sasva\OneDr...ments\match test.spr
Ci\Users\sasva\OneDr...ments\match test.spr
C:\Users\sasva\OneDr...stproddddddjectZ.spr

Exit

New Project Ctrl+N

Open Project... Ctrl+0 No sprite is opened for editing

Save Project Ctrl+S Double-click on an image on the left-side image list.
Save Project As...

Export as Source Code » Export to File
C:\Users\sasva\OneDr...ents\testproject.spr Export to Clipboard Cri+E

Export with Comments and Metadata

[ |

TERGHT——— OOF DYIeS SUZI0)

The .bas extension will export the data in BASIC language format with decimal numbers in DATA

lines.

The .inc format is a Macro Assembler (or compatible) formatted file where the bytes and the sprite

labels are rendered respectively.

When the Export with Comments and Metadata option is turned on, the output file will be more

verbose, containing sprite comments from metadata.

Using the Automatically export source code on
save option on the Project Metadata and
Settings page, each time when the sprite project
is saved, the preferred export file is also placed to
the selected path. By default the export file is
placed into the directory where the project file is
opened from. Click on the ... button next to the
path will allow to specify the target directory and
format.

The exported files can be processed using the
include command, provided by the used
assembler or BASIC compiler.

Project Sprites  Project Metadata and Settings

Project Name |Test project v1.1

Comments ‘ comment line 1
comment line2

Platform |Commadure 16/Plus4
Created On 2022.02.12 11:22:33
Length 664 bytes (30298)

iAdtomatically export source code. on save:
Include comments and metadata in source

Export to | \testproject inc




Compatibility settings

When your external assember/compiler requires different syntax as the code generator provides by
default, go to the Project Metadata and Settings tab and click on Advanced button. This opens a
dialog box where you can adjust the code generator settings. For example the line comments syntax
can be changed from ; to // when your compiler needs different notation.

Example export of a sprite project in Macro Assembler format. (The Export with Comments and
Metadata option was turned on.)

H Retro Sprite Workshop Project (c:\file
; Generated On: 2022. 02. 23. 22:27:45

; Project Name: Test Project

; Project Comments:

; Target Platform: Commodore 16/Plusd

; Project Created On: 2022.02.12 11:22:33

Sprite 1 :

; Sprite ID: sprite_38

; Sprite Comments: Captured from Screenshot (l.png)
PosX=80; PosY=64

; Dimensions: 8 x 8 pixels
; Color Mode: Multicolor (4 colors, 2 bits per pixel)
; Byte Order: CharacterBased

sprite_38_WIDTH_PX EQU
sprite_38_HEIGHT_PX  EQU
sprite_38_BIT_PER_PX EQU
sprite_38_NUM_FRAMES EQU
sprite_38:
BYT $00, $00, $00, $00, $00, $00, $00, 300

Sprite 2

; Sprite ID: sprite_10

; Sprite Comments: Captured from Screenshot (l.png)
PosX=144; Posy=112

; Dimensions: 8 x 8 pixels
; Color Mode: Hi-Res (2 colors, 1 bit per pixel)
; Byte Order: CharacterBased

sprite_10_WIDTH_PX EQU
sprite_l0_HEIGHT_PX  EQU
sprite_10_BIT_PER_PX EQU
sprite_l0_NUM_FRAMES EQU
sprite_10:
BYT $3f, $3f, $c0, 3c0, $fc, $fc, $c0, 5c0

Pre-rendered software sprites

Source sprite (8x8 pixels, 1 bit per color mode)

Image Metadata and Settings Image Metadata and Settings

Width | Bpixels (1 byte) v

Height 8 = [[] Mutticolor (2 bits per pixel) Image ID sprite
| Comments |
Source Code Generator Settings

Pre-render Software Sprites

Final Compiled Size 128 bytes




Exported output of the sprite above

Generated On: 2022. 02. 24. 15:51:55
i Project Name: Blank Project
7 Project Comments:

; Target Platform:
;i Project Created On: 2022.02.12 11:22:33

Sprite 1
; Sprite ID: sprite
; Sprite Comments:
; Dimensions: 8 x 8 pixels
; Color Mode: Hi-Res (2 colors, 1 bit per pixel
; Byte Order: Vertical
; Pre-rendering: High8Frames

sprite WIDTH_PX
sprite HEIGHT_PX
sprite BIT PER_PX
sprite NUM FRAMES
sprite framel:
BYT s$ff, $81, $81, $81, s$81, $81, $81, $ff, $00, $00, $00, $00, $00, $00, 500, $00

sprite frame2:
BYT $7f, $40, $40, 3540, s40, $40, s$40, $7f, $80, $80, $80, $80, $80, $80, 3580, s$80

sprite frame3:
BYT $3f, $20, $20, 520, $20, $20, $20, $3f, $c0, $40, $40, 540, $40, $40, 3540, s$cO0

sprite framed:
BYT $1f, $10, $10, $10, sl10, $10, $10, $1f, $e0, $20, $20, $20, $20, $20, 520, se0

sprite frame5:
BYT $0f, $08, $08, 508, s08, $08, s$08, $0f, $f0, $10, $10, $10, $10, $10, 510, sfO

sprite frame6:
BYT 507, $04, $04, 504, 504, 504, 3504, 507, $f8, $08, $08, 508, 508, $08, 508, s5f8

sprite frame7:
BYT 503, $02, $02, $02, 502, $02, 502, $03, sfc, $04, 504, 504, 504, 304, 3504, sfc

sprite frame8:
BYT 501, $01, $01, $01, 501, $01, $01, $01, $fe, $02, $02, 502, $02, $02, 502, sfe

j ==================== Retro Sprite Workshop Project END

Please note that each individual rendered frame is labeled correctly for later reference from the
code. Each frame contains a , bitwise shift right” version of the previous one. The original 8x8 pixels
image became 16x8 (2 bytes width) with an additional column of bytes to make room for the shift
operation.

Capturing sprites from emulator screenshot

When you are porting existing program from one environment to another (for example from
Commodore 64 to Commodore Plus/4) the capture tool is a powerful solution to grab the graphic
elements. Instead of figuring out how the graphic elements are stored in the memory (checking
emulator memory snapshots), you can capture the graphic elements right from the emulator
screenshot.

When you get a standard 320x200 pixels image from an emulator screen (sample images can be
found here: https://mozai.com/writing/brucemap/) Please make sure that the picture is not anti-

aliased or filtered/compressed. The best effect is a pixel-to-pixel representation of the original screen
in a lossless image.

To add new sprite to your project from a screenshot, click on Capture new from Screenshot button
ont he project image page. (Or Edit menu -> Add New Sprite -> Capture Sprite from Screenshot
command). The capture tool will appear and offer possibility to open an image from file or use the
image currently available on the Clipboard.



When the proper image is loaded, the screen will look similar to this:

Capture Sprite from Screenshot - 1.png = O X

File Edit View

Sprite Capture Settings
Cutter Width 8 pixels (1 byte) v

Cutter Height l e
Mutticolor O
Palette Mapping
Bl eogoed v -
- Character v
[ [ma2 v
g- B e v
IV
- Character ~
- Character v v

Preview Captured Sprite

© PosX=129; PosY=72; CutterX=125; CutterY=68 ‘plocm: 300% b4

On the right side, the Sprite Capture Settings are available. Here you can specify what kind of image
element you want to capture. The Palette Mapping list contains all colors available in the screenshot.
One-by-one you should define the behavior of each colors of the screensot. The Preview Captured
Sprite area is the final representation of your captured image.

After an image is loaded, you can drop the Capture Frame (Cutter) wherever you want ont he screen.
Later, you can drag and drop the frame to a different location. After setting the size and the position
of the capture frame, the preview are shows the final result. When necessary, adjust the Palette
Mapping to match the colors correctly.

It is strongly recommended to zoom the screenshot to higher ratio (above 500%) to make fine
positioning of the Capture Frame available.

Strange results after dropping the Capture Frame

o Geplure Scfre This is an example of the bad mapping.

The most common reason for this kind of result is a wrong color
mapping between screenshot image and target pixel roles.

Two different colors in the Capture frame are mapped to the
same target color and the resulting sprite was generated
incorrectly. The green area consists of the same color and we

Two different
colorsin the lost the possibility to distinguish the leg from the background.
Capture frame are
mapped to the

iﬁmﬂtll'ﬂ!tcolﬂ'

The role of the dark gray color is specified incorrectly. It is
configured as character color, but definitely that color is a
background color from the point of sprite’s view. When that

color is defined as Background, the preview image will be rendered again, showing the proper image.



When you are not sure where is the given color in

the Palette Mapping list, you can map the color

directly from the image. Carefully right-click on a Miswe Cigilioe Eratrie Hone

pixel in the screenshot and select the Map Pixel Scrollto Capture Frame F4

Map Pixel Color as

r Background Color

Color as menu item from the context menu, then Match Characters from Sprite Set. F5

select the appropriate role.

Zoom

A || Sprte Capture Settings

Cutter Wicth 24 piels (3bytes)

Multicolor M
Palette Mapping

Muti

n
i

Multi1 Color
» Multi2 Color
Character Color

Ok, the sprite looks better now, but the colors are not matching
Caterogt 21 - in the captured image. The reason is that the image was
rendered correcly and the pixels are set regarding to their real
roles, but the sprite colors should also be set tomake a lifelike
rendering. Right click on the preview area and set the character

- Character ~ .
B e - color accordingly.
Bl coece = Preview Captured Sprite
B e« When you pick a black color, -
Preview Captured Sprite . . . .
- the sprite will look similar to
B o the screenshot. Keep in mind Change Background Color...

Change Multi1 Color...
Change Multi2 Color...

EI that the sprites are containing
,palette color indices” from

Change Character Color...

o i 0-3 and their real colors are
provided by the proper TED or VIC registers.

Capture -

When the preview looks correct, click on the Capture button. The Capture window will close and you

will get back to the sprite editor to retouch and finalize the sprite when necessary.

When you need to

capture a new sprite, the Capture tool will appear with the same image and settings loaded.

o TR You can initiate capturing from the editing window of an
Width | 24picels 3bytes) ~ Byte Order | Viertical (Software Sprie) v . . . .
hest 2 SR — existing sprite. Using the popup menu from the Raster

T Clasrimage

Shift Image

»
Flip Image »
»
Rotate image »

| Capture Sprite from Screenshot... |
I Rearrange Color Pixels...

e - |

Editing Area, the Capture tool will be opened using preset
- size and color mode settings from the current sprite.




Supporting character mode screen and Building Character Set

The Capture tool offers functionality to build Character Sets and build character screens using the
loaded screenshot.

Sprite Capture Settings
Cutter Width 8 pixels (1 byte) v
CterHeght 8 : For building a Character Set , define a 8x8
Mukicalor %] . .
ﬂ”m pixels Capture Frame size (VIC and TED
Backgound v ) .
— e supports 8x8 pixels characters) and capture
(] v an image exactly from a character boundary
| BEEEE - .
— i (The grid lines can be turned on and aff using
B G Ctrl+G or using the View menu Gridlines
- Character - v
Proview Caphred St command.) Please be careful, characters
captured off the character boundaries will
prevent the function working properly. When
- this sprite is captured and avaiable in the
project image list, the Capture tool is able to
__&pnn
match the presence of the existing 8x8

sprites from your sprite collection.

To display matched characters, go to the View menu and click on Match Characters from Sprite Set
command or press the F5 key.

Warning: Using this calculation-intensive functionality might degrade performance on slower
computers.

Capture Sprite from Screenshot - 1.png

File  Edit

View
: G"d L|nes ctr|+G .............

Scroll to Capture Frame F4

Match Characters from Sprite Set  F5

Zoom

When the matching against existing sprites feature is turned on, the screen will mark the matched
items with a crossed character section. The status bar on the lower left corner summarizes the
number of matched characters and the positions for statistical purposes. When you hover the mouse
over a marked character, a popup bubble will display which sprite is found on that position and how
often that character is used on the screen. Please keep in mind that this tool relies on the current
Palette Mapping settings. When the palette mapping colors are set incorrectly, characters cannot be
matched (or not all characters are available for matching).

The ,,[index: xx]” indicator in the bubble shows the index of the matched sprite. It is recommended
to not mix bigger images within the 8x8 sprites in sequence. When your project sprite set starts with



the characters and later the bigger sprites, the character matching will provide you proper
information about the character codes found. When your character set finally assembled to the

begin of a character set on the target platform, the index 0 means the @ character, the index 1 is for
letter A and so on.

Capture Sprite from Screenshot - 1.png

File  Edit  View

|| Sprte Captuse Settings

Cutter Wicth 8 piels (1 byte) >
Cutier Height 8 =

slicllelle]=]] €l

Character Match in Sprite Set
Sprites sprite 2 [index: 2] (in 21 positions)

>

I 1 character(s) matching in 21 position(s) | ¢ PosX=228; Pos¥=131; CutterX=280; CutterY=80; CutterCharX=35; CutterCharY=10; ﬁZom 700% v




Recommended practice to reference character codes in source code

When you are using this project ..instead of referencing ...use dynamicreferences like
to define a character set, hardcoded character codes

containing readable letters like

Name index  Detais game over text game over text

y, Bitpe BYT $07 ;letter
?\:;::erﬂasad BYT $01 ;letter
,  Sx3puck BYT $0d ;letter
S Denctoes BYT $05 ;letter
. BYT $20 ;space BYT space char index
Oac MO BYT $0f ;letter o BYT o char index

2ok BYT $16 ;letter BYT v _char index

D“ L, s BYT $05 ;letter BYT e char index
4 T BYT $52 ;letter r BYT 1 =

BYT g char index
BYT a char index
BYT m:char:index
BYT e char index

[OIN= e}

o <

r char index
8x 8 pocels - -
Byte Order.

CharacterBased
2 colors

£x 8 poels

Byte Order
CharacterBased
2 colors

P §x 8 pocels
Byte Order
CharacterBased
2colors

] 8x 8 pinels

2 colors

The _char_index suffix for the sprite name equals to the Char: value from the Index column of the
image list. When you dynamically relocates the characters in your set (for example adding new
characters before the letter ,A”) your code will reference the proper character code during
compilation.

In case you are combining multiple projects into one character set, the project included later into
your code would restart the character indexing which brings negative effect to the character
referencing.

; lower chars

#INCLUDE "characters 0-127.inc"
;upper chars
$INCLUDE "characters 128-255.1nc"

;wrong reference, char index will be misaligned
character example
BYT char in upper charset char index

Due to the character index counter starts with 0 for each project, the upper chars part will start also
with 0 by default. When you are referencing the first character from upper chars by _char_index, you
will get value 0 instead the expected 128. To avoid this, the ,characters 128-255.prj” file
should be configured to start character indexing with 128.

To do that, use the Char Index Offset settings (on the Project Metadata and Settings tab) to control
the initial value of character index setting. This change will immediately recalculates the Char: value
on the image list view.

_ Name Index  Details
Automatically export source code on save
1. 8 x 8 pixels
Include comments and metadata in source == Byte Order
r : o 12«? CharacterBased
Export to | \hangar_charset.inc 2 colors
8 x 8 pixel
Char Index 128 = 2 a;e Order
Offset i b [1‘;'3" CharacterBased
2 colors




Version History

ver0.9 Initial Release
ver0.9a Added new menu item to Sprite Capture tool to make one-pixel horizontal
alignment for supporting multicolor sprite cutting
Capture Sprite from Screenshot
File | Edit | View
Resize Capture Frame  »
IAIign with one pixel I
verl.0 Added Char Index information for GUI and for exported file format. This
shows the exact character code of the image within a character set.
Project Sprites  Project Metadata and Settings
Mame Index Details
16 x & pixels
. | Byte Order:
:l: S E D' CharacterBased
2 colors
8x 8 pinels
. - Byte Order:
sprite_] {Char: 2 CharacterBazed
2 colors
This data also included in assembly export format.
space WIDTH PX EQU
space HEIGHT PX EQU
space BIT PER PX EQU
space INDEX EQU
|space CHAR INDEX EQU (]
space NUM FRAMES EQU
ver 1.1 Copy/Paste support for moving sprites from one project file to another
ver 1.2 Char Index Offset settings added to Project Metadata tab page

Automatically export source code on save
Include comments and metadata in source

Export to Ahangar_charset inc

Sk 128 -




ver 1.3

Code Generator compatibility settings on Project Metadata tab
Project Sprites  Project Metadata and Settings

Project Name ‘Test project v1.1

Comments comment linel ~
line2s

line3

asd

asdas

dasd

asd (V]

Platform Commodore 16/Plus4

Created On 2022.02.12 11:22:33
Length 3480 bytes ($0d98)

Automatically export source code on save
Include comments and metadata in source

Export to ‘I:\plusd\Micmassmlbler\bruce et
Char Index T
Offset 0 o Advanced...

Added Grid and Cutter color scheme selector for better visibility

I""P ] Grid Lines » | Dark
Scroll to Capture Frame F4 Soft
Match Characters from Sprite Set  F5 Light

v
Zoom 4 Auto

Added Border Size setting to support screenshots opened directly from
emulator containing borders

Border Size X |
Horizontal Border (margin on the top) 0 & pixels
Vertical Border (margin on the left) 0 + pixels

Aoly Cancel

ver 1.3

Added image manipulation commands to the Sprite Editor area context

menu: Insert/Remove Row/Column




Image Metadata and Settings
Width 8 pixels (1 byte) v Byte Order  Mixed (Character-Based) v

Height 8 () Mutticolor (2 bits per pixel)

r

Clear Image »
Flip Image r
Shift Image 3
Rotate Image >

Capture Sprite from Screenshot...

Rearrange Color Pixels...

Row 4 Insert Row

Column 4 Remove Row




